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Introduction 
 

Welcome to your Learner’s Guide for the Marble Technician Program. It will help you to complete the program and to go on to complete further study 
or go straight into employment. 

The Marble Technician program is to engage young people with a program of development that will provide them with the knowledge, skills and 
understanding to start this career in Pakistan. The program has been developed to address specific issues, such as the national, regional and local 
cultures, the manpower availability within the country, and meeting and exceeding the needs and expectations of their customers. 

The main elements of your learner’s guide are:  

• Introduction:  
o This includes a brief description of your guide and guidelines for you to use it effectively 

• Modules:  
o The modules form the sections in your learner’s guide  

• Learning Units:  
o Learning Units are the main sections within each module 

• Learning outcomes:  
o Learning outcomes of each learning units are taken from the curriculum document  

• Learning Elements:  
o This is the main content of your learner’s guide with detail of the knowledge and skills (practical activities, projects, assignments, 

practices etc.) you will require to achieve learning outcomes stated in the curriculum 
o This section will include examples, photographs and illustrations relating to each learning outcome 

• Summary of modules:  
o This contains the summary of the modules that make up your learner’s guide 

• Frequently asked questions:  
o These have been added to provide further explanation and clarity on some of the difficult concepts and areas. This further helps you 

in preparing for your assessment.  
• Multiple choice questions for self-test:  

o These are provided as an exercise at the end of your learner’s guide to help you in preparing for your assessment. 
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Module 5: Develop basic computer operating skills 
 

Objective of the Module: This module covers the skills and knowledge required to Operate MS word, Operate MS Excel, Operate MS Power Point, Perform       

Browsing and Print Document. 

 

 

Learning Unit   
Learning Outcomes  Learning Elements  

Materials  

Required  

LU1. Operate MS word Trainee will be able to: 

 Perform Microsoft basic 

commands in MS word  

 Open File 

 Format a file 

i. Font 

(Type/size/bold/Italic) 

ii. Header Footer 

iii. Page number 

iv. Insert pics / 

table/hyperlink 

 Save a File 

 Save a folder 

 Knowledge of Basic parts of 

computers 

 Importance and use of MS Word 

 Procedure to perform 

various functions in Home 

tab 

 

 Computer 

 Windows CD 

 MS office CD 

 

LU2. Operate MS 
Excel   

Trainee will be able to: 

 Perform basic commands in 

Microsoft MS Excel 

 Open a worksheet. 

 Sum functions 

 If functions 

 Importance and uses of MS Excel 

 Procedure to perform various 

functions in Home tab 

 

 Computer 

 Windows CD 

 MS office CD 
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 Basic calculations 

 Table and graphs 

 Save a worksheet/folder 

LU3. Operate MS 
Power Point 

Trainee will be able to: 

 Prepare Microsoft power point 

presentation with basic 

commands 

 Make a power point file 

 Insert pics/table/hyperlink 

 Design a theme for slides 

 Save a power point file 

 Importance and use of MS Power 

Point 

 Procedure to develop 

presentation 

 

 Computer 

 Windows CD 

 MS office CD 

 

LU4. Perform 
Browsing 

Trainee will be able to: 

 Perform browsing on the 

internet as per needs  

 Perform search online on new 

trends in the market with the 

help of internet 

 Importance of Internet. 

 Use of various search engines like 

Google, YouTube etc. 

 Computer 

 Internet connection 

LU5. Print Document 

Trainee will be able to: 

 Select Printer  

 Select page setup  

 Print relevant pages 

 Printing Procedure and 

techniques. 

 

 Computer 

 Printing 

 papers 

 (A4 and Legal size) 
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Examples and Illustrations:  

 

Basic Parts of a Computer 

 

A. Input Devices:  

1. Keyboard 

2. Mouse 

3. Microphone 

 

 

B. Process: 

CPU Central Processing Unit 

 

 

C. Output Devices 

1. Monitor 

2. Printer 

3. Speaker 
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MS Word: 
Microsoft Word is a word processing program that was first made public by Microsoft in the early 1980s. It allows users to type and manipulate text 
in a graphic environment that resembles a page of paper. Extra features, such as tables, images and advanced formatting give users more options 
to customize their documents. Over the past three decades, there have been a number of updates and additions to Microsoft Word. Today it is one 
of the most widely used word processors available for Macs and PCs. It is often taught to students in schools and required as part of the basic 
computer requirements for many office jobs. Here you will learn the basic functions of Microsoft Word and how to use them. 

 

Alignment – The alignment options dictate whether the left and right edges of the text in a document adhere to the right side, left, center or justified. 
Alignment can be set from the formatting toolbar at the top of the window or under by choosing “Paragraph” under the Format menu. 

 

Bullets/Numbering – When creating a list of text items, users can choose from several bullet or numbering system to add a small graphic icon or 
series of numbers before each item. To add bullets or numbering to a series of text, click on the corresponding buttons in the formatting toolbar or 
choose “Bullets and Numbering” from the Format menu. 

 

Copy – Copying text simply means making a replica of any text that is currently selecting and saving it to the clipboard. Pressing the Control and C 
keys in Windows or Command and C on a Mac will copy the text. Alternatively, users can also select the text and then click the “Copy” option under 
the Edit menu or in the main toolbar. 

 

Cut – Cutting text removes the text entirely from the viewable document and stores it in the clipboard. Control-X or Command-X are the keyboard 
shortcuts for the Cut function on Windows and Mac respectively. The Cut function can also be found under the Edit menu or the toolbar. 

 

Document – Each document in Microsoft Word is essentially a new file. Each document can be several pages long. A new document can be created 
by hitting Control-N or Command-N, or by choosing the “New Blank Document” option from the File menu or the standard toolbar. 

 

Edit – The edit menu or toolbar in Microsoft Word allows users to perform basic editing functions in their document such as copying, cutting and 
pasting. It also contains options for the Undo and Find/Replace functions. 

 

Font – A font is a type of design for text and typically incorporates this design into each letter, number and symbol found on a keyboard. Fonts can 
range from formal to whimsical. Microsoft Word comes with a series of provided fonts and additional ones can also be downloaded if needed. To 
change the font used in a document, select the text and either click on the main Font menu, the Font drop-down menu in the formatting toolbar or hit 
Control-D or Command D. 

Footer – The footer is the text that consistently appears on every page of a document, at the bottom of each page. Footers normally include details 
such as the page number, or a company’s name and contact details in formal documents. Add or edit a footer by choosing “Header and Footer” 
under the View menu. 
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Format – The Format menu (or toolbar) goes one step further than the Edit menu. Users can make stylistic changes by changing the look of the text 
itself, paragraphs, lists and more. 

 

Header – The header is similar to a footer except that it sits at the very top of every page in a document. Headers often contain page numbers, the 
document name or sub-titles within a document. The header can be edited by clicking on “Header and Footer” within the View menu. 

 

Justify, left justified, right justified – Justification is a type of alignment for text in a word processor. Justify ensures that both the left and right sides 
of the text in every paragraph run in a straight line. Left justify makes only the left side of the text aligned, while the right side remains ragged. Right 
justified does the complete opposite, with only the right side of the text aligned. Users can apply justification to their text by clicking on the 
corresponding buttons in the formatting toolbar or by selecting the text and clicking on “Paragraph” under the Format menu. 

 

Open – The Open command opens an existing document in Microsoft Word. Command or Control plus O, or choosing “Open…” from the File menu 
will provide a pop-up window for users to select the document they wish to open. 

 

Paste – The paste command takes any previously copied or cut text and lays it down within the document where the cursor is pointing. Control or 
Command plus V, or “Paste” from the Edit menu or standard toolbar will run the paste function. 

 

Print – The print command first opens a window where users can specify parameters of the paper, printer and ink they wish to print with and it 
provides a preview of what the physical print will look like. Control or Command plus P, or clicking on “Print” in the File menu or standard toolbar lets 
users access the print window. 

 

Save – The save command is one of the most important ones. It saves all of the work done to date within a document. The save command enables 
users to return to the same document later and continue writing, editing or printing. Control or Command plus S, or clicking “Save” under the File 
menu or standard toolbar will save the document. The “Save As” option is slightly different; it allows users to save the document as a different version 
by adding a different file name. 

Undo – The undo feature keeps track of each command that a user issues while working on their document. Issuing the undo command allows the 
user to go back one step and restore the document as it was before their latest editing command. Related to the Undo command is Redo, which lets 
the user redo the same formatting command again. Control or Command plus Z, or “Undo” under the Edit menu is used to undo a command, while 
Control or Command plus Y or “Redo” under Edit is to redo a command. 
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Keyboard Shortcuts for Microsoft Word 

Shortcuts Keys Operation 

Ctrl+X Cut 

Ctrl+C Copy 

Ctrl+V Paste 

Ctrl+Z Undo 

Ctrl+Y Redo 

Ctrl+S Save 

Ctrl+P Print 

 

Shortcuts for moving around easily / quickly in Word 

Home Beginning of line 

End End of line 

Ctrl + Home Go to start of document 

Ctrl + End Go to end of document 

Right Arrow Right one character 

Left Arrow Left one character 

Ctrl+Right Arrow Right one word 

Ctrl+Left Arrow Left one word 
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Text Formatting Shortcuts in Word 

Ctrl+B Bold 

Ctrl+I Italics 

Ctrl+U Underline 

Ctrl+Shift+L Bulleted list 

Ctrl+L Align left 

Ctrl+R Align right 

Ctrl+E Align centre 
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MS Excel 

 

Microsoft Excel is a program that provides worksheets comprised of rows and columns. Data can be stored in the worksheet, also called a 
spreadsheet, similarly to a Microsoft Word table, but the power of Excel is its ability to perform simple to complex mathematical calculations, and 
other functions. An Excel worksheet, or spreadsheet, is a two-dimensional grid with columns and rows. 

 

What are Excel Formulas? 

Excel formulas help you identify relationships between values in the cells of your spreadsheet, perform mathematical calculations using those values, 
and return the resulting value in the cell of your choice. Formulas you can automatically perform include sum, subtraction, percentage, division, 
average, and even dates/times 

 

1. SUM   

All Excel formulas begin with the equals sign, =, followed by a specific text tag denoting the formula you'd like Excel to perform.  The SUM formula 
in Excel is one of the most basic formulas you can enter into a spreadsheet, allowing you to find the sum (or total) of two or more values. To perform 
the SUM formula, enter the values you'd like to add together using the format, =SUM (value 1, value 2, etc.). The values you enter into the SUM 
formula can either be actual numbers or equal to the number in a specific cell of your spreadsheet. 

You can also practice the Division, Multiplication, subtraction, Percentage etc.  

 

2. IF 

The IF formula in Excel is denoted =IF (logical test, value_if_true, value_if_false). This allows you to enter a text value into the cell "if" something 
else in your spreadsheet is true or false. For example, =IF(D2="Pass","10","0") would award 10 points to cell D2 if that cell contained the word 
"Gryffindor." 

There are times when we want to know how many times a value appears in our spreadsheets. But there are also those times when we want to find 
the cells that contain those values, and input specific data next to it. 

We'll go back to the example for this one. If we want to award 10 points to everyone who belongs in the Pass Group, instead of manually typing in 
10's next to each Pass student's name, we'll use the IF-THEN formula to say: If the student is in Pass, then he or she should get ten points. 

The formula: IF(logical test, value_if_true, value_if_false) 

Logical Test: The logical test is the "IF" part of the statement. In this case, the logic is D2="Pass." Make sure your Logical Test value is in quotation 
marks. 

Value_if_True: If the value is true -- that is, if the student is Pass -- this value is the one that we want to be displayed. In this case, we want it to be 
the number 10, to indicate that the student was awarded the 10 points. Note: Only use quotation marks if you want the result to be text instead of a 
number. 

Value_if_False: If the value is false -- and the student does not Pass -- we want the cell to show "0," for 0 points. 
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Microsoft PowerPoint  
Microsoft PowerPoint is undoubtedly the most popular app used to give presentations. You're likely to see PowerPoint presentations used for 
everything from the world's largest companies to grade school teachers sharing lessons. 

Here are the key actions you'll need to take to build a PowerPoint presentation: 

You'll need to add slides, the individual pages in the presentation. 

You'll add content to the slides, such as text boxes, images, charts and graphs. 

Change themes and styles to make your presentation look professional and fit the occasion at hand. 

Prepare presentation aids like Speaker Notes and Presenter View to help you feel comfortable with presenting 

The Ribbon 

The ribbon menu is found across many of Microsoft's apps, such as Word, Excel, and PowerPoint. It lives above the main area of the application. 

 

 
 

 

 

 

The ribbon contains a series of tabs that you can switch between. Each of these have a unique set of tools to work with your presentation differently. When you 
switch tabs on the ribbon, you'll see new buttons and options to modify your presentation: 

 File. Save, share, and export your presentation. 

 Home. A general-purpose collection of the most common tools that you'll use in PowerPoint. 

 Insert. An all-in-one tool to add every imagine-able type of content, such as tables, pictures, charts, video, and more. 

 Design. Controls the overall look and feel of your presentation with theme and style settings. 

 Transitions. Add animations when you switch slides. 

 Animations. Controls the order and style that objects will enter or exit your slide with. 

 Slide Show. Control settings related to the way your presentation appears when sharing it with an audience. 

Now that you understand the layout, you have a better idea of how you can jump to the feature you need. 
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Print a Document 
 

 Open the document or file you want to print. 

 In the top portion of the window of the program or browser you are using, the File menu is in the upper-left corner of the screen. 

 If you clicked File, select Print from the drop-down menu. 

 Either option opens a Print properties window or automatically starts printing the document or file. 

 If the Print properties window is showing, you can specify additional printing options, such as how many copies you want or which specific 

pages you want to print. Once you've selected the options, click Ok or Print to start the printing process. 
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Module 6: Construct Geometrical Figures 

Objective: This module covers the skills and knowledge required to Take Measurement, Draw different types of triangles, Draw all six types of 

quadrilaterals, Draw Circle and its parts,  Draw polygons, Draw Ellipses and Draw Parabola  

Duration:  200 Hours                Theory: 35 Hours                  Practice: 165 Hours 

 
Learning Unit   

Learning Outcomes  Learning Elements  
Materials  

Required  

L1. Take 

Measurement 

Trainee will be able to: 

 Identify measuring Instruments. 

 Perform measurement as per drawing.  

 Mark the job as per drawing 

 Drawing Instruments/equipment 

 Scales and its interconversion. 

 Types of measuring Instruments 

Computer 

Windows CD MS office 

CD 

L2. Draw 
different types of 
triangles. 

Trainee will be able to: 

 Distribute space in required parts. 

 Draw equilateral triangle of side length 2”. 

 Draw isosceles triangle with base 5 cm and height = 6 

cm 

 Draw scalene triangle of lengths 2”, 1.5”, 1”. 

 Draw acute angled triangle. 

 Draw right angles triangle. 

 Draw obtuse angled triangle. 

 Draw tile strip & title block on drawing sheet 

 Procedure for the construction of angles. 

 Types of triangles 

 Construction techniques of different triangles. 

MS office CD 

 

L3. Draw all six 
types of 
quadrilaterals  

Trainee will be able to: 

 Distribute space in required parts. 

 Draw square of side length 2”. 

 Types of quadrilaterals.  

 Construction techniques of different 
quadrilaterals 

 MS office CD 
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 Draw rectangle with length 5 cm and width= 3 cm 

 Draw rhombus of side length=2 cm & internal angle= 

450 

 Draw parallelogram of length 6 cm, width= 3 cm & 

internal angle= 450 

 Draw trapezoid of parallel sides’ length 4 cm & 6 cm 

spaced at a distance of 3 cm. 

 Draw trapezium of side lengths 5 cm, 4 cm, 6 cm & 3 

cm. 

 Draw tile strip & title block for drawing sheet 

L4. Draw Circle and 

its parts 

Trainee will be able to: 

 Draw circle of diameter 2 Cm.  

 Draw semi-circle of diameter 2 Cm,  

 Draw segment of circle of diameter 2 Cm,  

 Draw sector of circle. 

 Draw zone of circle of diameter 2 Cm.  

 Draw tile strip & title block for drawing sheet 

 State the terms used in a circle. 

 Describe different lines and arcs in a circle. 
 

  

L5. Draw polygons,  

Trainee will be able to: 

 Draw a regular pentagon of side length = 4 cm. 

 Draw hexagon inscribes in a circle of 6 Cm diameter. 

 Draw hexagon circumscribed about a circle of 6 Cm 

diameter. 

 Draw tile strip & title block for drawing sheet 

 Types of polygons. 

 Construction techniques of different polygons 

 Printing 

 papers 

(A4 and Legal size) 

L6. Draw Ellipses  

major axis = 10 cm  
minor axis = 8 cm 

with four 
methods. 

Trainee will be able to: 

 Draw ellipse by four centers method. 

 Draw ellipse by basic method. 

 Draw ellipse by parallelogram method. 

 Draw ellipse by off-set method in concentric circles. 

 Define Ellipse.  

 Construction techniques of different Ellipses 

  

L7. Draw Parabola  

major axis = 10 cm 
minor axis = 8 cm 
with Three methods. 

Trainee will be able to: 

 Draw parabola by basic method. 

 Draw parabola by tangent method. 

 Draw parabola by rectangle method 

 Define Parabola 

 Construction techniques of different 
Parabolas 

  
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Examples and Illustration: 

Measuring Tools: 
 

The Tape Measure 

 

A tape measure or measuring tape is a flexible ruler. It 
consists of a ribbon of cloth, plastic, fiber glass, or metal strip 
with linear-measurement markings. It is a common measuring 
tool. Its design allows for a measure of great length to be 
easily carried in pocket or toolkit and permits one to measure 
around curves or corners. 

 
 

The Chalkline 

 

A chalk line or chalk box is a tool for marking long, straight 
lines on relatively flat surfaces, much farther than is practical 
by hand or with a straightedge. 

It is an important tool in construction and carpentry, the 
working of timber in a rough and unplanned state, as it does 
not require the timber to have a straight or squared edge 
formed onto it beforehand. 
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Ruler:  

A typical ruler is going to be useful in so many different 
situations. Everyone knows how a ruler works, as you 
simply line it up with something to determine how long 
it is.  

Professionals use rulers every single day to help with 
their work. Whether it is an architect using a ruler to 
help to design a building, or a construction worker 
determining if his work is straight, rulers are going to 
be important. You’ll see so many different people 
making use of rulers on a regular basis. It’s always 
smart to own a reliable ruler, even if you’re just using it 
for academic purposes. 

 

 

The Level 

 

Every woodworker needs a couple of levels. You probably 
won’t need one of the 6-foot levels used in construction, but 
48” is a good length for many of the woodworking projects 
you’ll do. Usually, you’ll also need an 8” level too, usually 
known as a torpedo level. You’ll check the level and plum of 
your construction. Level is horizontal, and plumb is vertical. 
Most quality levels are made of either brass-edged wood or 
of metal. There will be a bubble reading for level, and another 
one for plumb. When the bubble is exactly between the lines, 
you have a level or plumb surface. You can also get string 
levels and laser levels, but the woodworker will use these 
types of levels the most often. 

 



BASIC 

WOODWORKING Draftin
g 

 

                     Learner’s Guide-Marble Technician- NVQF – Level - 2  Page | 17  

 

The Layout Square 

 

 

A layout square (sometimes also referred to as a combination 
square) is a triangular-shaped measuring tool designed for 
making square marks or angles on stock. 

 

The layout square has three major functions. First and most 
often, it is used for making square marks on a piece of stock. 
Second, a layout square has markings making it easy to 
determine an approximate angle of a mark or cut. Finally, a 
layout square allows the user to mark angles in a similar 
manner to the method for determining an existing angle. 

 

 

The Caliper 

 

A caliper (British spelling also caliper, or in plural tantum 
sense a pair of calipers) is a device used to measure the 
distance between two opposite sides of an object. A caliper 
can be as simple as a compass with inward or outward-facing 
points. The tips of the caliper are adjusted to fit across the 
points to be measured, the caliper is then removed and the 
distance read by measuring between the tips with a 
measuring tool, such as a ruler. 
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Before we begin drafting, let’s first look at the tools you will need. 

1. Graph paper: A sheet of paper with a series of squares aligned in columns and rows filling the sheet useful for drawing images to scale. 

 

2. Pencil: Do not draw in ink. Always use a pencil, and begin with a light sketch. You will darken the lines later. 

 

 

3. Straight edge: A straight edge is precisely that…a straight edge. It is a hard, smooth tool used for guiding your pencil to assure that your lines are straight. 

Always use a straight edge. Do not freehand sketch a finished drafted plan. The most common straight edge used for drawing horizontal lines is a T-square, 

which is also used to hold drafting triangles (see below). 

 

 
4. Circle template: A circle template is a smooth, hard flat tool used for drawing circles or arcs. 

 

 

 

5. Drafting compass: A drafting tool used for drawing circles or arcs. 

 

 

 

 

 

 

6. Triangles: Triangles are flat surfaces shaped like triangles used for drawing straight lines 
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Units of Length Conversion Charts 
https://www.math-only-math.com/units-of-length-conversion-charts.html 

In math when we use length, we know that the standard unit of length is ‘Metre’ which is written in short as ‘m’. 

A metre length is divided into 100 equal parts. Each part is named centimetre and written in short as ‘cm’. Thus, 1 m = 100 cm and 100 cm = 1 m 

The long distances are measured in kilometre. This kilometre equals to 1000 metres. The kilometre is written in short as km. 

1 kilometre (km) = 1000 metres (m)         Or  1 km = 1000 m 

The different units of length conversion charts and their equivalents are given here: 

1 Metre (m) = 10 Decimetres (dm) = 100 cm = 1000 mm 

1 Decimetre (dm) = 10 Centimetres (cm) 

1 decimeter = 0.1 meter 

1 Centimetre (cm) = 10 Millimetres (mm) 

1 centimeter = 0.01 meter 

1 millimeter = 0.001 meter 

Mostly we use Kilometre (km), Metre (m) and Centimetre (cm) as the units of length measurement or unit of length conversion chart. 

 

https://www.math-only-math.com/units-of-length-conversion-charts.html
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Examples of conversion: 

http://mhariati.blogspot.com/2010/07/length-conversion-units-of-length.html 

 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

http://mhariati.blogspot.com/2010/07/length-conversion-units-of-length.html
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What are the different types of triangles? 
https://www.pinterest.co.uk/pin/574701602419445279/ 

 

The sum of angles in any triangle is 180°. 

  

https://www.pinterest.co.uk/pin/574701602419445279/
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Equilateral 

An equilateral triangle has three equal sides and angles. It will always have angles of 60° in each corner. 

 

 

1. Draw an equilateral triangle with side 5 cm. 

 
Step 1: Draw a straight line 5 cm long. Call it AB. 
   

 

 

Step 2: Using a Protector draw an angle of 60° from point A:  

 

Each angle of an equilateral triangle is 60°. 

 

 

 

 

 

 

 

Step 3:  Using a Protractor draw an angle of 60° from point B.  
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Step 4: Mark the point where both these lines meet as C. 

 

  

CHECK 

1.   Measure the lengths of lines AC and BC. 

2.   They should each be equal to 5 cm. 
3.   Using a protractor measure ∠ACB. 
4.   It should be equal to 60°. 
5.   Δ ABC is the required equilateral triangle. 

Each side of an equilateral triangle is of the same length. 
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Quadrilaterals and Types of Quadrilaterals 
https://www.mathsteacher.com.au/year10/ch06_geometry/06_quadrilaterals/quad.htm 
https://www.toppr.com/guides/maths/understanding-elementary-shapes/types-of-quadrilaterals/ 

Quad means four and lateral means sides. All closed figures with four sides are called quadrilaterals. The sides of the quadrilateral may be equal, 
unequal, parallel or irregular which forms the basis of varying shapes in these four-sided shapes. Whatever may be the external shape, every 
quadrilateral has four sides, four vertices and with all its angles adding up to be 360 °. 

Types of Quadrilaterals and their Properties 

There are six basic types of quadrilaterals: 

1.  Rectangle 

 Opposite sides are parallel and equal. 

 All angles are 90º. 

 The diagonals bisect each other. 

 

 
2.  Square 

 Opposite sides are parallel and all sides are equal. 

 All angles are 90º. 

 Diagonals bisect each other at right angles. 

 

https://www.mathsteacher.com.au/year10/ch06_geometry/06_quadrilaterals/quad.htm
https://www.toppr.com/guides/maths/understanding-elementary-shapes/types-of-quadrilaterals/
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3.  Parallelogram 

 Opposite sides are parallel and equal. 

 Opposite angles are equal. 

 Diagonals bisect each other. 

 

4.  Rhombus 

 All sides are equal and opposite sides are parallel. 

 Opposite angles are equal. 

 The diagonals bisect each other at right angles. 

 

5.  Trapezium 

 A trapezium has one pair of opposite sides parallel. 

 A regular trapezium has non-parallel sides equal and its base angles are equal, as shown in the 

following diagram. 

6.  Kite 

 Two pairs of adjacent sides are equal. 

 One pair of opposite angles is equal. 

 Diagonals intersect at right angles. 

 The longest diagonal bisects the shortest diagonal into two equal parts. 
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Circles 
https://www.mathplanet.com/education/geometry/circles/basic-information-about-circles 

A circle is all points in the same plane that lie at an equal distance from a centre point. The circle is 
only composed of the points on the border.  

The distance between the midpoint and the circle border is called the radius. A line segment that has 
the endpoints on the circle and passes through the midpoint is called the diameter. The diameter is 
twice the size of the radius. A line segment that has its endpoints on the circular border but does not 
pass through the midpoint is called a chord. 

 

Polygons: 
https://www.ducksters.com/kidsmath/polygons.php 
A polygon is a flat figure that is made up of straight lines and is enclosed. 
 
A few notes on the definition of a polygon that hopefully will help you remember: 

 Flat - this means it's a plane figure or two-dimensional 
 Straight lines - these are called segments in geometry 
 Enclosed - all the lines fit end-to-end and form a figure with no openings. 

More on what enclosed means. The following figures are not enclosed and are not polygons.  

  

 

 

https://www.mathplanet.com/education/geometry/circles/basic-information-about-circles
https://www.ducksters.com/kidsmath/polygons.php
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The following figures are enclosed and are polygons: 
 

   
 
Types of Polygons 
 
There are a lot of types of polygons. Some you've probably heard of before like squares, triangles, and rectangles. We'll learn more about these 
and others. Polygons are named for the number of sides they have. Here is a list of polygon names depending on the number of sides they have, 
starting with three and ending with ten. 

 3 sides - Triangle 
 4 sides - Quadrilateral 
 5 sides - Pentagon 
 6 sides - Hexagon 
 7 sides - Heptagon 
 8 sides - Octagon 
 9 sides - Nonagon 
 10 sides - Decagon 

There are, of course, polygons with many more names and sides. 
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Ellipse: 

https://kids.kiddle.co/Ellipse#:~:text=Videos-,Ellipse%20facts%20for%20kids,that%20produces%20a%20closed%20curve. 

An ellipse is a shape that looks like an oval or a flattened circle. 

In geometry, an ellipse is a plane curve which results from the intersection of a cone by a plane in a way that produces a closed curve. 

Circles are special cases of ellipses, obtained when the cutting plane is perpendicular to the cone's axis. An ellipse is also the locus of all points of 
the plane whose distances to two fixed points add to the same constant. 

 

 

 

 

 

 

 

An ellipse and its properties. 

A circle has one center, called a focus, but an ellipse has two foci. 

An ellipse is simply all points on a graph that the sum of the distances from 2 points are the same. For example, an ellipse can be made by putting 
two pins into cardboard and a circle of string around those two, then putting a pencil in the loop and pulling as far as possible without breaking the 
string in all directions. The orbits of the planets are ellipses, with the sun at one focus and nothing at the other. 

 

Main Parts of an Ellipse 

http://sccs-tech.weebly.com/a-ellipse.html 

 

1. Major Axis (the long one) 
2. Minor Axis (the short one) 
3. Focal Points 
4. Vertex 

 

 

https://kids.kiddle.co/Ellipse#:~:text=Videos-,Ellipse%20facts%20for%20kids,that%20produces%20a%20closed%20curve.
http://sccs-tech.weebly.com/a-ellipse.html
https://kids.kiddle.co/Image:Elipse.svg
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Module 7: Develop Basic Communication Skills 

Objective: This module covers the skills and knowledge required to Adopt effective listening, Develop nonverbal communication, Develop verbal 

communication, Develop confidence and Pick the right medium.  

Learning Unit  Learning Outcomes  Learning Elements  Materials Required  

LU1. Adopt Effective 
Listening 

Trainee will be able to: 

 Practice active listening 

 Ask clarifying questions 

 Listen and sympathize with 

another person 

 Describe importance of active 

listening 

 Describe clarity of questioning 

 Explain importance of sympathizing a 

person 

 Multimedia 

 Stationery 

 Effective Listening 

Modules 

LU2. Develop Nonverbal 
Communication 

Trainee will be able to: 

 Adopt hand gestures if required  

 Encourage others to speak 

openly with you 

 Make eye contact with 

communicator 

 Make relaxed, open stance 

during communication  

 Perform friendly tone during 

communication 

 Explain importance of hand gestures 

 Describe importance of encouraging 

others to speak openly 

 Describe the importance of eye 

contact in communication 

 Describe the importance of open 

stance and relaxed communication 

 Explain the usefulness of friendly tone 

 Multimedia 

 Stationery 

 Non-Verbal 
Communication 
Modules 

LU3. Develop verbal 
communication 

Trainee will be able to:  Explain face to face conversation  Multimedia 

 Stationery 

https://www.thebalancecareers.com/active-listening-skills-with-examples-2059684
https://www.thebalancecareers.com/verbal-communication-skills-list-2059698
https://www.thebalancecareers.com/verbal-communication-skills-list-2059698
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 Adopt face to face conversations 

 Convey your message clearly and 

directly 

 Adopt phrases as simple as 

possible 

 Respect others and their ideas 

 Explain importance of clarity in direct 

messaging 

 Describe use of simple phrases 

 Describe importance of individual 

respect and their ideas  

 Verbal 
Communication 
Modules 

LU4. Develop Written 
Communication 
Skills 

 Trainee will be able to: 

 Convey your message in few 

words. 

  Convey message through live 

phone calls.   

  Convey message through 

Whatas.  

  Convey message through 

email. 

  Convey message through 

writing. 

 Describe self confidence in interaction 

with others 

 Describe usefulness of firm 

communication in friendly tone 

 Explain the importance of behavioral 

skills 

 Describe the usefulness of sound 

interpersonal skills 

 Define good understanding 

 Multimedia 

 Stationery 

 Written 
Communication skills 
Modules 
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Example and Illustrations:  

Good Listening Skill: 

Listening is one of the most important skills you can have. How well you listen has a major impact on your job effectiveness, and on the quality of 

your relationships with others. 

For instance: 

 We listen to obtain information. 

 We listen to understand. 

 We listen for enjoyment. 

 We listen to learn. 
 

Becoming an Active Listener 

There are five key active listening techniques you can use to help you become a more effective listener: 

1. Pay Attention 

Give the speaker your undivided attention, and acknowledge the message. Recognize that non-verbal communication also. 

 Look at the speaker directly. 

 Put aside distracting thoughts. 

 Don't mentally prepare a rebuttal! 

 Avoid being distracted by environmental factors. For example, side conversations. 

 "Listen" to the speaker's body language. 

 

2. Show That You're Listening 

Use your own body language and gestures to show that you are engaged. 

 Nod occasionally. 

 Smile and use other facial expressions. 

 Make sure that your posture is open and interested. 

 Encourage the speaker to continue with small verbal comments like yes, and "uh huh." 
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3. Provide Feedback 

Our personal filters, assumptions, judgments, and beliefs can distort what we hear. As a listener, your role is to understand what is being said. This 

may require you to reflect on what is being said and to ask questions. 

Ask questions to clarify certain points. "What do you mean when you say...." "Is this what you mean?" Summarize the speaker's comments 

periodically. 

 

4. Defer Judgment 

Interrupting is a waste of time. It frustrates the speaker and limits full understanding of the message. Allow the speaker to finish each point before 

asking questions. Don't interrupt with counter arguments. 

 

5. Respond Appropriately 

Active listening is designed to encourage respect and understanding. You are gaining information and perspective. You add nothing by attacking the 

speaker or otherwise putting her down. 

 Be candid, open and honest in your response. 

 Assert your opinions respectfully. 

 Treat the other person in a way that you think s/he would want to be treated. 
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What is nonverbal communication? 

Nonverbal communication is the transfer of information through the use of body language including eye contact, facial expressions, gestures and 
more. Verbal communication is the use of language to transfer information through written text, speaking or sign language. 

Nonverbal communication is important because it gives us valuable information about a situation including how a person might be feeling, how 
someone receives information and how to approach a person or group of people. Paying attention to and developing the ability to read nonverbal 
communications is an invaluable skill you can leverage at every stage of your career. 

 

Types of nonverbal communication 

There are several types of nonverbal communications you should be aware of, including: 

 

Body language: Body language is the way someone situates their body naturally depending on the situation, the environment and how they are 
feeling. For example, someone might cross their arms if they are feeling angry or nervous. 

Gestures: While gestures vary widely across communities, they are generally used both intentionally and unintentionally to convey information to 
others. Someone in the United States might display a “thumbs up” to communicate confirmation or that they feel positively about something, for 
example. 

 

Facial expressions: One of the most common forms of nonverbal communication is facial expressions. Using the eyebrows, mouth, eyes and facial 
muscles to convey can be very effective when communicating both emotion and information. 

Touch: Some people also use touch as a form of communication. Most commonly, it is used to communicate support or comfort. This form of 
communication should be used sparingly and only when you know how the receiving party feels about touch. It should never be used to convey 
anger, frustration or any other negative emotions in the workplace. 
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Verbal Communication 

Strong verbal communication skills are important for everyone to master. They are extremely valuable in both your personal and professional life. 
When speaking clearly, confidently, and with poise, you are much more likely to command the respect of others and build rapport. This is particularly 
important in business interactions 

Nonverbal elements such as posture, gestures, and facial expressions are also important factors in developing good verbal communication skills. 
Ultimately, good speakers should make frequent eye contact with the audience, let their facial expression show their interest in the ideas they are 
presenting, dress in a way that is appropriate for the occasion and keep their energy levels high. 

Here are the reasons why Oral Communication is great 

 It saves time, 

 It is more effective as emotions are well portrayed, 

 The feedback loop is faster, 

 Verbal communication is economical, 

 The tone is easy to read  

 

Factors of Effective Verbal communication: 

1. Think before you speak  

By organizing your thoughts in advance, you can eliminate many of the awkward pauses that occur when speaking. It will also help you relay your 
information more concisely. 

While writing down your thoughts is not always possible in spontaneous discussions, it is still effective to take a minute to organize your thoughts in 
your mind before you begin to speak. 

 

2. Speak with confidence  

Speaking in a confident manner will help you build trust and command the respect of your audience. There are several factors which can impact 
your ability to speak confidently, including your command of the subject matter, your word choice, the tone of your voice, your body language, and 
your ability to make direct eye contact with your audience. 

3. Be clear and concise  

The most effective way to get your point across is to make it in a clear and concise manner. Avoid using complex, convoluted sentences, and try to 
state your argument in direct language. Before speaking, ask yourself, “What is the clearest way I can make my point?” 
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4. Be aware of your non-verbal communication cues  

Your body language significantly impacts the way others interpret what you say. Pay attention to the gestures you make, your facial expressions, 

and your body language to ensure they align with the message you are trying to get across. 

 

5. Be a good listener 

Being a good listener is as important as being a good speaker, and it will improve the quality of your verbal interactions. It shows the people you are 

speaking with that you genuinely care about their ideas, and it helps ensure you understand their needs. This will enable you to build trust and rapport 

much quicker. 

 

6. Think about the perspective of your audience  

Just because you have a strong command of a topic doesn’t mean the people you are speaking to have the same knowledge as you. 

Try to think about how someone else will understand what you are trying to communicate, particularly if they lack the technical knowledge about a 

subject that you possess. 

 

7. Vary your vocal tone  

Speaking in a monotone voice is a surefire way to bore your audience. Instead, use voice inflection to add emphasis to important points, and vary 

the pitch of your voice to express emotion. This will help keep your audience engaged in your message. 

 

Effective verbal communication is an important skill to understand. Having the courage and ability to convey your thoughts in a respectable way will 

help enhance mutual understanding, trust, decision-making, and problem-solving between yourself and others, making the act of properly speaking 

and listening to an imperative influence on how we learn and think for ourselves. 
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Written Communication Skills: 

Written communication skills can be useful, even crucial, for career success. If you're good at business writing, you're more likely to create a good 

impression. But if you aren't getting the message across clearly with your words, your chances for getting jobs, promotions, raises and bonuses may 

be harmed. 

Whether you’re sending a winning cover letter to a hiring manager, a memo to a colleague, a report to your team or an email to a client, crisp, highly 

focused and error-free writing signals that you’re someone who is organized, knowledgeable and detail oriented. 

Conversely, written communications that are long-winded, imprecise or strewn with typos leave readers wondering how you handle other aspects of 

your job. If your business writing abilities are a weakness, the time to improve is now. 

How to Make Your Writing Communicate? 

Effective writing allows the reader to thoroughly understand everything you are saying. This is not always easy to do. Here are a few tips that will 

help you: 

1. Know your goal and state it clearly. Do you want the reader to do something for you or are you merely passing along information? Do you 

want a response from the reader or do you want him to take action? Your purpose needs to be stated in the communication. Avoid 

information that is not relevant. Clarity is key. 

2. Tone can help your writing be more effective. Certain forms of communication, like memorandums and proposals need a formal tone. 

Writing to someone you know well would need a more informal tone. The kind of tone depends on the audience and purpose of the writing. 

3. Explain in clear terms what you want the reader to do. They cannot oblige if they do not understand. Also, they may not even want to try to 

help if the communication is vague and sloppily written. It is good to include why it is beneficial to them to do what you ask or to help you. 

4. Language needs to be simple. Do not overuse clichés, jargon, and expressions or try to impress with big words. Keep sentences and 

paragraphs short and concise. 

5. Less is more when it comes to length. Leave out words that do not contribute to the main focus of the communication. This can make the 

reader work harder to know why you wrote. 

6. Using an active voice will strengthen your writing. Sentences that are written in the active voice will flow better and are easier to 

understand. Long, complicated sentences will slow the reader down, even more so if they are written in the passive voice. An active 

example is "I caught the ball." and a passive example is "The ball was caught by me." Active voice will engage the reader and keep his 

attention. 

7. Good grammar and punctuation are very important. It is a good idea to have someone else proofread your writing before you send it. If you 

cannot do that, then try reading it out loud. 
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Module 8: Prepare Workplace/ Housekeeping 

Objective: This module covers the skills and knowledge required to arrange stones, Arrange drainage of polluted water, Identify location for dumping 

marble waste, Prepare log sheet for general maintenance, Treat damaged stone, Maintain Inventory, Ensure clear travel path, Store 

slabs (size, color, grade ), and Load Marble Slabs. 

Duration: 100 Hours                   Theory: 21 Hours                                 Practice: 79 Hours 

Learning Unit Learning Outcomes  Learning Elements  
Materials  

Required  

LU1. Arrange Stones 

(Color, Size, Grade)  

Trainee will be able to: 

 Clean work place.  

 Perform safe Unloading of Marble Stone. 

 Mark stone as per (color, size and  

grade   

Cleaning Techniques of stone yard.  

Types, categories and grade of stones 

Loading and Unloading techniques of 
Marbles Stones  

 

 

LU2. Regulate 

drainage of polluted 

water 

Trainee will be able to: 

 Check condition of water tanks.  

 Regulated flow of polluted water to the tank.  

 Dispose-off of the marble waste from the water 

tank  

 Dispose-off the marble waste from work place 

Knowledge of Harm polluted water 

Recycling of Harm polluted water 

 

 

LU3. Identify location for 

dumping marble waste  

Trainee will be able to: 

 Estimate quantity of marble waste.  

 Arrange location for dumping of marble scrape.   

Locations of stocking various items 
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LU4. Prepare log sheet 

for general maintenance 

Trainee will be able to: 

 Prepare schedule of routine maintenance 

 Identify the activities for conducting routine 

maintenance 

 Prepare list of tools for routine maintenance 

Importance of log sheet/Work order  

LU5. Maintain Inventory 

Trainee will be able to: 

 Estimate weight of raw materials and size of 

finished stock.  

 Maintain record of all blades 

 Maintain stock register.   

Importance of inventory management  

LU6. Ensure clear travel 

path 

Trainee will be able to: 

 Mark the width of travel path.  

 Maintain clear path.  

Importance of clear travel path  

LU7. Store slabs (size, 

color, grade) 

Trainee will be able to: 

 Identify store for Slabs.  

 Arrange space for storage of marble tiles.  

 Store the marble tiles according to color, size 

and grade 

Knowledge about slabs storage   

LU8. Load Marble Slabs 

Trainee will be able to: 

 Identify parking location for vehicle to be 

loaded.  

 Load marble Slab/Tiles Safely in vehicle. 

Loading and Unloading techniques of 
Marbles / Slabs 
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Example and Illustrations:  

Marble, Onyx and Granite belong to the category of building stones widely known as Dimension Stone, These are natural stones which can be 
shaped in form of blocks, slabs, tiles, etc. and are mostly used for monumental and decorative purposes since antiquity, various civilizations have 
used dimension stone in many ancient buildings and monuments that have survived to the present day. Although numerous varieties of igneous, 
metamorphic and sedimentary rocks are used as dimension stone, the principal rock types used are granite, limestone, marble, sandstone and slate.  

Major deposits of high-quality Dimension Stone available in a wide range of colors, shades and patterns could not be exploited so far due to lack of 
modern quarrying and manufacturing facilities. This hindered the development of marble and granite sectors. Consequently, despite being accorded 
the status of industry over a decade ago and other continuing efforts of Federal and Provincial Government and other stake holders as Pakistan 
Stone Development Company 

 

 

Marble, Onyx, Slate & Granite  
https://www.tdap.gov.pk/doc_reports/tdap_report_on_marble_and_granite.pdf 

Pakistan has enormous wealth of marble, re-crystallized lime stone, fossiliferous limestone, dolomite and granite. These materials occur on the 
surface suitable for open cast bulk  

 

MARBLE  

Marble is a crystalline, compact variety of metamorphosed limestone, consisting primarily of calcite (CaCO3), dolomite (CaMg (CO3)    or a 
combination of both minerals. Pure calcite is white, but mineral impurities add color in variegated patterns.  

 

Marble is a durable stone in dry atmosphere and when protected from rain. The surface of marble crumbles readily when exposed to moist or acid 
atmosphere. Purest form of marble is statuary marble, which is white with visible crystalline structure. The distinctive lustre of statuary marble is 
caused by light penetrating a short distance into the stone and then being reflected from the surfaces of inner crystals. 

 

Construction marble is a stone which is composed of calcite, dolomite or serpentine which is capable of taking a polish. More generally in construction, 
specifically the Dimension stone trade, the term "marble" is used for any crystalline calcitic rock (and some non-calcitic rocks) useful as building 
stone. 

 

Not specifically measured, however Marble & Onyx more than 300 billion tons of reserves are estimated. They are mainly available in White, Black, 
Green, Pink, Grey, Brown and Yellow colors. Main mining locations includes Mohmand Agency, Chitral, Buner, Swat, Parachinar, Gilgit, Hunza, 
Swabi, Bajour, Mardan, Wazirstan, Azad Kashmir, Lasbela, Chagai & Khuzdar.  

 

 

 

https://www.tdap.gov.pk/doc_reports/tdap_report_on_marble_and_granite.pdf?__cf_chl_jschl_tk__=057b0deb66f2878570ee7e921b454b045bd86f56-1596369244-0-AVDC6h9ItZOTw12DVkuvKFGRxz7PHX5GOxq6UV33WA4ydaQyQTXnyo-Dsv4z3hVaOzxI7zN8yCSLxrSZ0aK77afL5TvFcAuGGyhBfdX0vD74X29ADbQR-RjbFyGHp6kEp4ohmqxwTFnrM9425aL0YRXsgeh5dQAWhHiSZO_xwUcgSuw1IE3L9SRkvUyHmDy6NI1gcmsLbeT5gjjyyxSrIUckWSXB4QUEJIoPg-dBvCHSHSVYbKRCTYGt1PEdwXrd9I7MH-keJLhPIyJS7MwMon4_byCeZhtekygIEa4lt_Zgbaajh5FAEEBus-lZ2pTKSF0l8iWE8r5273bVvez5kK0
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ONYX  

Onyx is favorite in the world markets and is used for facing, flooring and decorative items. Similar to most of the other forms of marble, it is composed 
of compact rocks of carbonate nature of sedimentary origin formed through chemical precipitation usually in underground cavities. Generally found 
in the form of big lenses and patches with a low relief. If the crystals are particularly large (some centimeter) and visible to the naked eye, these 
rocks are known as alabaster. Onyx is mostly green in color with fine texture, nevertheless bands and patches of red, brown, and white are common, 
with rare patches of golden. Green variety is more valuable because it is used for special works in many parts of the world. Major deposits are located 
in Mexico, Iran and Turkey with best green variety in Afghanistan and Pakistan. 

 

Granite: 

Granite, is igneous rock of visible crystalline formation and texture. It is composed of feldspar (usually potash feldspar and oligoclase) and quartz, 
with a small amount of mica (biotite or muscovite) and minor accessory minerals, such as zircon, apatite, magnetite, ilmenite, and sphene. Granite 
is usually whitish or gray with a speckled appearance caused by the darker crystals.  

Granite is mainly preferred for its use in the exterior applications including funeral trade. Variety of colors in granite is traded in the world market with 
different price tags. High price is fetched for the rare colors including Jet- Black, Pearl Blue and Deep Green. These colors are found in South Africa, 
Brazil, Norway, India and Pakistan. 

Granite has greater strength than sandstone, limestone or marble and is correspondingly more difficult to quarry. It is an important building stone, 
and its maximum usage is in the external flooring and facing followed by internal flooring. 

 

 Not specifically measured, however more than 1000 billion tons of granite reserves are generally estimated. MAJOR COLOURS Black, Pink, Grey, 
Green, Gold & Yellow and Red LOCATION Gilgit, Dir, Chital, Swabi, Kohistan, Nagarparker, Chagai, Mansehra, Malakand & Swat. Nagarparkar 
(Sindh) and Mansehra (Khyber Pukhtoonkhwa) are only known sources of workable Granite in the country. Geology evidence shows Gilgit Region 
holds great promise of the superior quality deposits. 

 

Slate 

Slate is dense, fine-grained rock, formed by the metamorphism of shale or clay or more rarely of igneous rocks. Many rocks that show “slaty cleavage” 
are by extension loosely called slate. True slate is hard and compact and does not undergo appreciable weathering. The basic minerals comprising 
slate are quartz, mica and hematite. Slate is commonly bluish-black or gray-black in color but red, green, purple, and variegated varieties are also 
found. Slate is quarried usually in open pits and rarely in underground workings. The stone splits best when it is freshly taken from the quarry. Slate 
is used for floors, roofs, electrical panels, window and doorsills, baseboards, stair treads, paving stones, laboratory tabletops and sinks. It is widely 
used for structural and industrial purposes; polished slate is used in interior designs as well. 
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Marble loading and storage:  
Construction materials are often heavy and irregularly shaped, leading to considerable material handling challenges. In any facility that houses 
building materials, though, slabs of marble, granite, and stone may be the toughest items to store and transport. These unique materials require 
specialized equipment and proper training to keep staff safe. 

 

Arrival and unloading of marble blocks 

https://www.pulycort.com/en/marbles/marble-processing.html 
 https://na.bhs1.com/safe-material-handling-storage-marble-granite-stone-slabs 

Once the blocks have been extracted from the quarry, these are transported by HGV lorries to the manufacturers for processing. At each production 
center, the blocks are unloaded and classified in the blocks yard prior to being sawed. 

Due to their large dimensions and heavy weight, the blocks need to be moved and handled with cranes and specific machines, both during loading/ 
unloading and during processing. 

Blocks are generally stored outdoors in the block yard until the next phase: the marble processing phase. 
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Safe Material Handling and Storage for Marble, Granite, and Stone Slabs 
 

Construction materials are often heavy and irregularly shaped, leading to considerable material handling challenges. In any facility that houses 
building materials, though, slabs of marble, granite, and stone may be the toughest items to store and transport. These unique materials require 
specialized equipment and proper training to keep staff safe. Here are a few important tricks to be followed.  

 

1. Choose storage racks that are designed for heavy sheet materials 

Perhaps the most dangerous thing about stone building materials is that they’re incredibly heavy. Larger units can weigh 4,000 pounds or more. It is 
imperative to store such objects in racks that can handle these loads. Choose racking that’s made from thick, heavy-duty steel tubing. 

 

2. Inspect all racking before loading 

During loading and unloading, lesser racks may sustain minor dents and scratches that can lead to an eventual failure. That’s why it’s important to 
inspect racks before adding a load, in addition to periodic inspections as part of a comprehensive infrastructure plan. 

 

3. Discourage manual lifting at all times 

Not all stone slabs weigh thousands of pounds, but that’s no reason to allow staff to lift them by hand. Even a two-person lift, recommended by 
OSHA for all materials that weigh more than 50 pounds, is not enough when handling stone. 

Instead, be sure to supply material handling equipment that’s rated for the load. Cranes and lift trucks, combined with straps, clamps, or hooks, will 
prevent musculoskeletal injuries while moving stone slabs. Just make sure to train staff to secure loads completely before lifting. 

 

4. Train employees to avoid the “fall shadow” 

The first rule of working with marble or granite sheets is simple: Never stand in the slab’s “fall shadow,” or the area in front of or behind a slab stored 
vertically, or raised on a lifting device. That way, even if a slab topples or falls, staff can avoid the worst-case scenario. 

 

5. Make and Implement a High-Quality Training Plan 

One of the greatest dangers in material handling applications is the lack of pre-planned procedure. Before staff complete any lifting or storage task, 
management must identify any possible hazards, provide appropriate equipment, and educate staff on safety rules. 

 

6. Improving material handling with stone sheets 

The story that led to OSHA’s publication of the Bulletin covering storage and handling of granite, stone, and marble slabs is a tragic one. Between 
1984 and 2006, the agency found, 46 workers lost their lives to fallen stone slabs. By 2008, OSHA administrators realized that they had to address 
the hazards of working with heavy sheet materials. 
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Not only did they publish the document mentioned here, they also issued serious fines to businesses that failed to provide appropriate material 
handling equipment for stone slabs.  

Clearly, the nation’s workplace safety experts are concerned about the hazards of moving and storing stone. By following a few common-sense 
procedures, and by providing equipment that’s built for the challenge, every employer can safely work with slabs of stone, granite, and marble with 
remarkable efficiency. 

 

Polluted water and its recycling  
https://www.researchgate.net/publication/326677957_The_effects_of_marble_industries_effluents_on_water_quality_in_Swat_Northern_Pakistan 

 

Marble industries produce a bulk of waste materials. About 70% of this valuable mineral resource is lost during mining, its processing and in polishing 
procedures. These wastes are in different forms like rock fragments, effluents and dust particles. These are discarded either in nearby pasturelands, 
roads, riverbeds and agricultural fields or landfills. Thus, it is creating a wide range of environmental pollution especially of water bodies affecting 
aquatic life 

The effluents ooze out from marble industry could adversely affect the quality of groundwater sources that are particularly more adjacent to marble 
industry discharge units. This industrial discharge results in the degradation of water quality which causes health hazards and death of human beings, 
livestock and death of aquatic lives, affect crop growth and their quantity and quality. The lack of treatment facilities, financial resources and 
misconception of environmental laws and policies do further aggravate the problem. So, it is recommended that proper procedures should be adopted 
to prevent the flow of contaminated water discharges from different industries into water sources to protect human health and its environment. 

It is recommended that direct disposal of marble industry wastewater should be banned and all effluents must be properly treated before 

discharging in the river water. Wastewater treatment consists of removing pollutants from wastewater through a physical, chemical or 

biological process. The more efficient these processes are, the cleaner the water becomes. 
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Major Product Categories 
Stone extracted from the mines is raw material for the processing industry. Product types are described in two major categories “mining and 
Processing”. 

 

Mining 
Raw Blocks 

Standard sizes of the block in the international market are having the following specifications. 

 

Length : 1.9-meter, 2.6 meter 

Width : 1.4-meter, 1.8 meter 

Height : 1.1-meter, 1.4 meter, and 1.8 meter 

 

Standard weight of these blocks are 13.7 tons- 22.7 tons. There are however large size blocks weighing up to 30 tons. 

 Unfortunately, in Pakistan primitive mining techniques does not allow extraction of standard blocks. In addition, Poor infrastructure with pathetic road 
condition impedes transporting heavy loads, thus restricting the product to smaller sizes with irregular shapes. Mine products in Pakistan can be 
classified as under. 

 

a. Large Blocks 

These blocks are generally bigger in size weighing up to 8 tons and above in rare cases. Lager blocks are extracted normally in limited quantities at 
the mine sites as blasting results in producing more fragmented and small size material. Out of the total 10% is extracted as large blocks. 

 

b. Small Blocks 

These usually range between 5-7 tons. These blocks are cheaper because of their size as slabs, a high value-added product, can rarely be obtained 
from them at the processing end. These blocks have share of 10% of the total quarry production. Together with large blocks they constitute 20% of 
total output. 

 

Boulders 

These are comparatively small round blocks with standard weight of 2 tones. These are normally byproducts in the international mining. In Pakistan 
boulders form main product line. This category of mine extract contributes to 30% of the total quarry production in the domestic mines. Boulders are 
used for making tiles of size, 12 x 12 inch, 6 inch x 6 inch, 6 inch x 4 inch. Good color material is used for manufacturing handicrafts including, office 
table sets, flower vases, ashtrays etc. 
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Chowka 

Chowka is smaller than boulders usually weight up to 50 kg apiece, cut and processed by micro units on machinery having 18 inches cutters. These 
units process Chowka for small tiles like, 6 inch X 4 inch, 4-inch X 4 inches etc. In the international mining Chowka and Kanda are considered to be 
mine wastes. Total extraction of Chowka from mine is around 40% of the total production. Other buyers of this product are crushing units, which 
produce chips of different sizes (used normally in the flooring). 

  

Kanda 

Kanda is the local terminology used for the scrap produced at the mine site resulting from blasting. Good color material is used for chip making. 
Kanda contributes to 10 % of the quarry production. Among the other usage of Kanda include construction, floor bedding and wall making. 

 

 

 

Processing 
Intermediate Products 

 

Intermediate products require further processing before they are sold in the market to the consumers or ready for their use. These include slabs and 
unfinished tiles of different sizes and thickness. Slabs are normally sold to the local processors and distributors, however some of the large size good 
quality slabs are exported. 

 

a. Slabs 

Slabs are large semi processed sheets of marble stone with varied sizes and thickness of 2 inch. They are further processed in the local industry or 
exported to the international markets. Slabs are cut on gang saws from large blocks of marble and granite. This product is used for tabletops, kitchen 
tops, wall facing, flooring and other allied purposes. Price of slab varies with the quality of material and the size of the sheet.  

 

b. Unpolished Tiles 

These are processed and sold by units normally lacking machinery to finish and section the material. These are available in different sizes, colors 
and shades. These tiles are polished normally after application at the desired surface. Main attraction for the consumer for this product is its low 
price. Unpolished tiles are sold comparatively at cheaper rate. This product is also purchased by small and medium processing units at Lahore and 
Karachi, who process is further including sectioning and polishing and sell it to the market. 
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Finished Products 
 

Finished products include, properly cut to size slabs, tiles of different sizes and varieties, and decorative. These are high value-added products and 
are sold at higher prices, depending on the stone colors. The designers and architects normally determine the sizes of finished tiles. Finished product 
can be sold in the local markets as: 

 

a. Polished Tiles 

These are the fully processed tiles sold in the market at competitively higher prices, which depend on vein structure color & shades. In the countries 
with developed processing base highly calibrated tiles are produced and traded in the world market. 

 

b. Decorative Items 

Decorative items including, pillars, fire places, railings, sculpture, flower vase, ashtrays, tabletops, office table sets and many other similar items are 
produced in many countries of the world. In the countries where labor cost is high, carving is done with CNC machines. In Pakistan these items are 
produced all over the country with manual labor. Major cluster of these items lies in Karachi, where 400 units are involved in this activity followed by 
a few units at Lahore and Rawalpindi. Prices of these items vary from product to product, the quality of craftsmanship, and stone used in these 
products.  

 

Marble Chips 

Marble Chips are tiny pieces normally of crushed marble used in flooring and facing in the construction industry. These are processed on completely 
different machinery set up that includes stone crushers of various grades. They vary in size from large grains of 1 inch to 0.5 centimeter, depending 
on the choice of the consumer.  
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Frequently Asked Questions 
 

1. What is Competency Based 
Training (CBT) and how is it 
different from currently offered 
trainings in institutes? 

Competency-based training (CBT) is an approach to vocational education and 
training that places emphasis on what a person can do in the workplace as a result 
of completing a program of training. Compared to conventional programs, the 
competency-based training is not primarily content based; it rather focuses on the 
competence requirement of the envisaged job role. The whole qualification refers to 
certain industry standard criterion and is modularized in nature rather than being 
course oriented. 

2. What is the passing criterion for 
CBT certificate? 

You shall be required to be declared “Competent” in the summative assessment to 
attain the certificate. 

3. What are the entry requirements for 
this course? 

The entry requirement for this course is 8th Grade or equivalent.  

4. How can I progress in my 
educational career after attaining 
this certificate?  

You shall be eligible to take admission in the National Vocational Certificate Level-3 
in Marble Technician. You shall be able to progress further to National Vocational 
Certificate Level-4 in Marble Technician Course; and take admission in a level-5, DAE 
or equivalent course (if applicable). In certain case, you may be required to attain an 
equivalence certificate from The Inter Board Committee of Chairmen (IBCC). 

5. If I have the experience and skills 
mentioned in the competency 
standards, do I still need to attend 
the course to attain this certificate? 

You can opt to take part in the Recognition of Prior Learning (RPL) program by 
contacting the relevant training institute and getting assessed by providing the 
required evidences. 

6. What is the entry requirement for 
Recognition of Prior Learning 
program (RPL)? 

There is no general entry requirement. The institute shall assess you, identify your 
competence gaps and offer you courses to cover the gaps; after which you can take 
up the final assessment. 

7. Is there any age restriction for entry 
in this course or Recognition of Prior 
Learning program (RPL)? 

There are no age restrictions to enter this course or take up the Recognition of Prior 
Learning program 
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8. What is the duration of this course? The duration of the course work is 1,510 hrs. (11 months) 

9. What are the class timings? The classes are normally offered 25 days a month from 08:00am to 01:30pm. These 
may vary according to the practices of certain institutes. 

10. What is equivalence of this 
certificate with other qualifications? 

As per the national vocational qualification’s framework, the level-4 certificate is 
equivalent to Matriculation. The equivalence certificate can be obtained from The 
Inter Board Committee of Chairmen (IBCC). 

11. What is the importance of this 
certificate in National and 
International job market? 

This certificate is based on the nationally standardized and notified competency 
standards by National Vocational and Technical Training Commission (NAVTTC). 
These standards are also recognized worldwide as all the standards are coded using 
international methodology and are accessible to the employers worldwide through 
NAVTTC website. 

12. Which jobs can I get after attaining 
this certificate? Are there job for this 
certificate in public sector as well? 

You shall be able to take up jobs in the local or overseas construction companies in 
heavy machinery operator job profile. 

13. What are possible career 
progressions in industry after 
attaining this certificate? 

You shall be able to progress up to the level of supervisor after attaining sufficient 
experience, knowledge and skills during the job. Attaining additional relevant 
qualifications may aid your career advancement to even higher levels. 

14. Is this certificate recognized by any 
competent authority in Pakistan? 

This certificate is based on the nationally standardized and notified competency 
standards by National Vocational and Technical Training Commission (NAVTTC). 
The official certificates shall be awarded by the relevant certificate awarding body. 

15. Is on-the-job training mandatory for 
this certificate? If yes, what is the 
duration of on-the-job training? 

On-the-job training is not a requirement for final / summative assessment of this 
certificate. However, taking up on-the-job training after or during the course work may 
add your chances to get a job afterwards. 

16. How much salary can I get on job 
after attaining this certificate? 

The minimum wages announced by the Government of Pakistan in 2019 are PKR 
17,500. This may vary in subsequent years and different regions of the country. 
Progressive employers may pay more than the mentioned amount. The heavy 
Machinery Operator normally earns 20,000 to 25,000 in the start.  

17. Are there any alternative certificates 
which I can take up? 

There are some short courses offered by some training institutes on this subject. 
Some institutes may still be offering conventional certificate courses in the field.  

18. What is the teaching language of 
this course? 

The leaching language of this course is Urdu and English. 
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19. Is it possible to switch to other 
certificate programs during the 
course? 

There are some short courses offered by some training institutes on this subject. 
Some institutes may still be offering conventional certificate courses in the field. 

20. What is the examination / 
assessment system in this 
program? 

Competency based assessments are organized by training institutes during the 
course which serve the purpose of assessing the progress and preparedness of each 
student. Final / summative assessments are organized by the relevant qualification 
awarding bodies at the end of the certificate program. You shall be required to be 
declared “Competent” in the summative assessment to attain the certificate. 

21. Does this certificate enable me to 
work as freelancer? 

You can start your small business by purchasing your own heavy construction 
machine and can start earning 50,000 per month. You may need additional skills on 
entrepreneurship to support your initiative. 

 

 




